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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2006-2007 Hewlett-Packard Development Company, L.P.

This product includes i-net OPTA software, which is © Copyright 2002-2007 i-net software GmbH, Berlin, 
Germany.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

AMD is a trademark of Advanced Micro Devices, Inc.

HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on all HP 9000 computers are Open 
Group UNIX 95 branded products.

Intel and Pentium are registered trademarks of Intel Corporation or its subsidiaries in the United States and 
other countries.

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.

Microsoft®  and Windows®  are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
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Support

Visit the HP Software support web site at: 

http://www.hp.com/managementsoftware/support 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many also require a 
support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

http://www.managementsoftware.hp.com/passport-registration.html 
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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1 Documentation Map
Figure 1 shows the documentation map for HP Operations Dashboard RealTime Health View. 
You can use this map to determine which manual contains the information you need. For a list 
of available product documentation, see RealTime Health View Documentation on page 10.

Figure 1 RealTime Health View Documentation Map
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RealTime Health View Documentation

Table 1 lists the documents in the RealTime Health View documentation set. These 
documents are provided in Adobe Acrobat (.pdf) format and are located in the following 
directories:

• On the HP Operations Dashboard management station:

<OvInstallDir>\paperdocs\dashboard\rhview

where <OvInstallDir> is the location where RealTime Health View is installed.

• On the product DVD-ROM:

\Docs\

• On the system where SLI is installed (for the SLI installation guide):

<OvInstallDir>\paperdocs

RealTime Health View Online Help

You can access RealTime Health View online help for HP Operations Dashboard Service 
Composer from the composer Help menu.

Table 1 RealTime Health View Documentation

Document Title and Filename Main Topics

HP Operations Dashboard Installation and 
Upgrade Guide
Installation.pdf

Installing, uninstalling, and upgrading 
HP Operations Dashboard

HP Operations Dashboard Migration Guide
Migration.pdf

• Migrating from SIP 3.2 to Operations 
View 2.1

• Migrating RealTime Health View and 
Operations View users to Jetspeed 
2.1.1

RealTime Health View Concepts Guide
RealTime_Health_View_Concept.pdf

Introduction to the terms and concepts of 
RealTime Health View

RealTime Health View Administrator Guide
RealTime_Health_View_Admin.pdf

• Configuring RealTime Health View
• Maintaining RealTime Health View

Smart Link Integration for BMC Remedy 
Help Desk Installation Guide
RemedyOvSLI\Remedy_SLI_Install.pdf

Installing Smart Link Integration (SLI) 
for Remedy Help Desk
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2 Introduction
This chapter provides an overview of HP Operations Dashboard RealTime Health View. It 
also provides information about basic configuration and administration tasks. 

This chapter includes the following topics:

• About HP Operations Dashboard on page 11

• About HP Operations Dashboard RealTime Health View on page 11

• Getting Started with RealTime Health View on page 13

 About HP Operations Dashboard

HP Operations Dashboard is a suite of tools that you can use to monitor the health and status 
of vital business, application, and IT services. You can use these tools to link existing service 
definitions from different management stations to create a customized dashboard view of your 
environment. HP Operations Dashboard consists of the following tools:

• HP Operations Dashboard RealTime Health View: enables you to look at high-level 
service-related data.

• HP Operations Dashboard Operations View: enables you to look at detailed 
operations-level data.

 About HP Operations Dashboard RealTime Health View

RealTime Health View enables you to collect, aggregate, and analyze service-related data 
from existing management stations in your environment. You can use this data to create a set 
of high-level aggregated views of application, business, and IT services. RealTime Health 
View provides the following components:

• RealTime Health View Composer

• RealTime Health View Portal

• RealTime Health View Adapters

• RealTime Health View Server

• RealTime Health View System Tray

For information about HP Operations Dashboard Operations View, see the 
Operations View documentation
  11



RealTime Health View Composer

You can use the composer module to design the portal views that your end users view. You can 
introspect services from selected management stations in your environment (such as those 
running HP Operations Internet Services, HP Operations for Windows, and so on) to provide 
high-level dashboard views. 

The composer module enables you to do the following:

• Import services from management stations such as HP Operations Internet Services, 
HP Service Navigator, and HP Service Desk. You can also import HTTP and SQL data 
sources.

• Create dashboards and define service groups. This enables you to display high-level 
service views grouped by geographies, business units, organizational units, and so on.

• Deploy any newly designed dashboard view so that it displays as a complete portal-based 
web site. 

RealTime Health View Portal

Your end users view the dashboards by using the portal view, which is a set of 
JSR168-compliant portlets that are autogenerated for the dashboards designed by using the 
composer. These portlets provide a consolidated view of services and enable end users to drill 
down to the elementary services. They also provide detailed information about each 
dashboard component including health metrics and other attributes.

The portal module provides the following:

• Summary views that show multi-dimensional aspects of a service, such as health, 
availability, service-level objective (SLO) compliance, alerts, and help desk incidents.   

• First-level drilldown portlets show the service hierarchies as defined by the service 
managers. These portlets also show cross-domain heterogeneous views of data from 
multiple products within a specified service context.

• Second-level drilldown portlets show additional details about selected dependent services 
from products such as HP Operations Internet Services and HP Service Navigator.

RealTime Health View Adapters

RealTime Health View adapters provide integration between the RealTime Health View 
server and the management stations from which it collects data. The adapters are web 
service-based applications that you deploy on each management station from which RealTime 
Health View collects data.

Adapters are available for the following HP products:

• HP Internet Services

• HP Service Desk

• HP Service Navigator

• HP Operations Manager for Windows

• HP Operations Manager for UNIX

Adapters designed to work with non-HP Operations management stations are called Smart 
Link Integration (SLI). SLIs are available for the following products:
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• BMC Remedy Help desk 

RealTime Health View Server

The RealTime Health View server acts as a repository for dashboards that you create. It also 
contains an engine that accepts runtime data from adapters and SLIs, and computes status 
for each of the dashboard components at runtime. 

RealTime Health View System Tray

The RealTime Health View System Tray tool shows the status of dashboards, deployed in the 
Dashboard server, on a client system. It provides the current status and status update alert 
for each dashboard. After you install and configure the system tray tool, it appears in the 
system tray of your system. 

 Getting Started with RealTime Health View

Before using RealTime Health View, you must configure it by using the Dashboard 
Configuration Manager. The Dashboard Configuration Manager enables you to configure 
connection parameters such as port number, polling interval, database, and portal server. It 
also enables you to start or stop the RealTime Health View servers.

For an overview of configuration and administration tasks, see Table 2.

Table 2 Organization of Tasks

Task 
Number

Task Name and 
Reference Description

1.0 See Installing and 
Configuring Adapters 
on page 15.

RealTime Health View collects data with the help of 
adapters. After you install RealTime Health View, you 
must install the necessary adapters on each 
management station or data source.

2.0 See Configuring 
RealTime Health View 
on page 37.

Configure RealTime Health View database details, 
server properties, and adapters.

3.0 See Creating 
Dashboards on 
page 57.

Create and deploy dashboards by using the 
HP Operations Dashboard Service Composer.

4.0 See Managing Users 
on page 79.

Add, delete, and manage users. Assign dashboards to 
portal users.
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3 Installing and Configuring Adapters
In order to retrieve data from selected management stations, you must first install and 
configure adapters on each management station or data source. This chapter contains 
information about the following topics:

• Finding the RealTime Health View Adapters on page 15

• Installing the Adapter for HP Internet Services on page 16

• Installing the Adapter for HP Service Desk on page 17

• Installing the Adapter for HP Service Navigator on page 20

• Installing the Adapter for HP Operations Manager for Windows on page 23

• Installing the Adapter for HP Operations Business Process Insight on page 24

• Installing the Adapter for HP Operations Manager for UNIX on page 26

• Installing the Adapter for HP Service Center on page 27

• Installing System Tray on page 28

• Verifying Adapter Installation on page 29

• Changing Adapter Port Numbers on page 31

• Uninstalling Adapters on page 32

Finding the RealTime Health View Adapters

The RealTime Health View installation wizard automatically installs the set of adapters in 
compressed format in the following location:

<OvInstallDir>\misc\dashboard\rhview

The compressed files include the following:

• For Windows systems: HPOvDshAdapter-WinNT4.0.zip 

• For HP-UX systems: HPOvDshAdapter-HPUX11.0.tar.gz 

• For Solaris systems: HPOvDshAdapter-SunOS5.7.tar.gz 

• For system tray: HPOvDshSysTray-WinNT4.0.zip

<OvInstallDir> is also the location of other HP Operations Dashboard files.
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Installing the Adapter for HP Internet Services

System Requirements

In order to install this adapter successfully, the target management station must meet the 
following minimum system requirements

Installation Tasks

1 Copy the file HPOvDshAdapter-WinNT4.0.zip to the HP Internet Services management 
station and extract the contents of the file.

2 Run the extracted files in the following sequence:

a HPOvXpl-03.10.040.msi

b HPOvJxpl-03.10.040.msi

c HPOvJREB-01.05.002.msi

d HPOvDshRhvCo-02.10.000.msi

e HPOvDshISAdapt-02.10.000.msi

3 To modify the HP Internet Services adapter configuration, edit the following properties 
file. 

<OvDataDir>\conf\ovdshisadapter\OVISAdapterConfig.properties 

Table 3 System Requirements for the Adapter for HP Internet Services

Software Requirements

Operating System Windows 2000, 2003

HP Internet Services  Versions 5.2, 6.1, and 6.2

Attribute Default Value Description

Port 80 The port on which the HP Internet Services management 
server is running

Hours 1 The number of hours over which to calculate drilldown data 
to determine the health of services and HP Internet Services 
service elements. The attribute accepts fraction values also. 
For example, to set a duration of half an hour, you can 
specify .5.
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4 Start the adapter as a service from the Services window.

Installing the Adapter for HP Service Desk

System Requirements

In order to install the adapter successfully, the target management station must meet the 
following minimum system requirements.

Installation Tasks

Perform the following steps to install and configure the adapter.

On Windows:

1 Copy the HPOvDshAdapter-WinNT4.0.zip to the HP Service Desk management station 
and extract the contents of the file. 

2 Run the extracted files in the following sequence:

Alarms ON The flag indicates whether HP Internet Services Alarms 
will be sent to the Dashboard server or not. By default, 
alarm messages will be sent. Change the flag’s value to OFF, 
if you do not want to send HP Operations Internet Services 
alarm messages to the Dashboard server. 

Heatlh_Pr
opagation

ON The flag indicates whether HP Internet Services Service 
Group's overall SLO health propagation to the 
Dashboard server will be done or not. By default, health 
propagation takes place. Change the flag’s value to OFF to 
stop health propagation.

Overall_H
ealth

YES The flag indicates how the health propagation takes place. 
Use this flag to get overall SLO health or individual SLO 
health, such as Availability and Response Time. Default 
value of the flag is YES, which indicates overall SLO health. 
You can set the flag’s value to AVAILABILITY or 
RESPONSE_TIME to get individual SLO health. This flag 
is used only if the Health_Propagation flag is ON.

Attribute Default Value Description

Restart the adapter every time you edit the OVISAdapterConfig.properties 
file.

Table 4 System Requirements for the Adapter for HP Service Desk

Software Requirements

Operating System Windows 2003, HP-UX 11.11 and 11.23 PA-RISC, Solaris 8 
and 9 (sparc)

HP Service Desk  Versions 4.5 SP 17, 5.x
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a HPOvXpl-03.10.040.msi

b HPOvJxpl-03.10.040.msi

c HPOvJREB-01.05.002.msi

d HPOvDshRhvCo-02.10.000.msi

e HPOvDshSDAdapt-02.10.000.msi

3 From the Start menu, click Programs → HP OpenView → Dashboard → RealTime Health View 
→ Configure SD Adapter. The HP Operations Dashboard Service Desk Adapter 
Configuration dialog box opens.

4 Enter the user name and password for the HP Service Desk application server, and then 
click Save. When you finish, click Exit.

5 To modify the HP Service Desk adapter configuration, edit the following properties file:

 <OvDataDir>\conf\ovdshsdadapter\OVSDAdapterConfig.properties

6 Start the adapter as a service from the Services window.

On HP-UX:

1 Copy the file HPOvDshAdapter-HPUX11.0.tar.gz to the HP Service Desk management 
station.

2 Extract the contents of the file to a local subdirectory <ExtractDir>.  

3 At the command prompt, install the extracted files by using the swinstall command. 
Make sure that you install the files in the listed sequence.

a swinstall -s 
<ExtractDir>/HPOvXpl-03.10.040.depot

b swinstall -s 
<ExtractDir>/HPOvJxpl-03.10.040.depot

Attribute Default Value Description

Hostname localhost The machine on which the 
HP Service Desk application server is running

Port 30999 The port on which the 
HP Service Desk application server is running

Restart the adapter every time you edit the OVSDAdapterConfig.properties 
file.
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c swinstall -s <ExtractDir>
/HPOvJREB-01.05.002.depot

d swinstall -s <ExtractDir>
/HPOvDshRhvCo-02.10.000.depot

e swinstall -s <ExtractDir>
/HPOvDshSDAdapt-02.10.000.depot

4 At the command prompt, run the file ovdsdpwdchg.sh from /opt/OV/bin. The HP 
Operations Dashboard Service Desk Adapter Configuration dialog box opens. 

5 Enter the user name and password for HP Service Desk application server, click Save, and 
then click Exit.

6 To modify the HP Service Desk adapter configuration, edit the following properties file.

/var/opt/OV/conf/ovdshsdadapter/OVSDAdapterConfig.properties

7 At the command prompt, run the file ovsd_adapter.sh from /opt/OV/bin . The 
adapter starts running as a daemon.

On Solaris:

1 Copy the file HPOvDshAdapter-SunOS5.7.tar.gz to the HP Service Desk management 
station.

2 Extract the contents of the file to a local subdirectory <ExtractDir>.  

3 At the command prompt, install the extracted files by using the swinstall command. 
Make sure that you install the files in the listed sequence.

a pkgadd -d 
<ExtractDir>/HPOvXpl-03.10.040.sparc

b pkgadd -d 
<ExtractDir>/HPOvJxpl-03.10.040.sparc

c pkgadd -d <ExtractDir>
/HPOvJREB-01.05.002.sparc

d pkgadd -d <ExtractDir>
/HPOvDshRhvCo-02.10.000.sparc

e pkgadd -d <ExtractDir>
/HPOvDshSDAdapt-02.10.000.sparc

4 At the command prompt, run the file ovdsdpwdchg.sh from /opt/OV/bin. The HP 
Operations Dashboard Service Desk Adapter Configuration dialog box opens. 

Attribute Description Default

Hostname The machine on which the 
HP Service Desk application 
server is running

localhost

Port The port on which the 
HP Service Desk management 
server is running

30999

Restart the adapter every time you edit the OVSDAdapterConfig.properties 
file.
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5 Enter the user name and password for HP Service Desk application server, click Save, and 
then click Exit.

6 To modify the HP Service Desk adapter configuration, edit the following properties file.

/var/opt/OV/conf/ovdshsdadapter/OVSDAdapterConfig.properties

7 At the command prompt, run the file ovsd_adapter.sh from /opt/OV/bin . The 
adapter starts running as a daemon.

On a HP Service Desk 4.5 system, the adapter for HP Service Desk uses the web-api.jar 
file to gather information from the HP Service Desk system. Installation of Service Pages 
adds web-api.jar file in the HP Service Desk system. 

On a HP Service Desk 5.1 system, the adapter for HP Service Desk uses the following jar files 
to gather information from the HP Service Desk system.

• OvObsWebApi-client.jar

• OvObsWebApi-common.jar

• OvObsWebApi-server.jar

• OvObsSDK.jar

• sd-webapi.jar

Installation of HP Service Desk management server adds first four jar files and installation of 
Service Desk Web API adds the sd-webapi jar file in the HP Service Desk system.

Installing the Adapter for HP Service Navigator

System Requirements

In order to install the adapter successfully, the target management station must meet the 
following minimum system requirements.

Attribute Description Default

Hostname The machine on which the 
HP Service Desk application 
server is running

localhost

Port The port on which the 
HP Service Desk management 
server is running

30999

Restart the adapter every time you edit the OVSDAdapterConfig.properties 
file.

Table 5 System Requirements for the Adapter for HP Service Navigator  

Software Requirements

Operating System HP UX 11.11 and HP UX 11.23 PA-RISC, Solaris 8 and 9 
(sparc)

HP Service Navigator  Versions 7.x and 8.x.
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Installation Tasks

On HP-UX:

Perform the following tasks to install and configure the adapter:

1 Copy the file HPOvDshAdapter-HPUX11.0.tar.gz to the HP Service Navigator 
management station.

2 Extract the contents of the file to a local subdirectory <ExtractDir>.  

3 At the command prompt, install the extracted files by using the swinstall command. 
Make sure that you install the files in the listed sequence.

a swinstall -s 
<ExtractDir>/HPOvXpl-03.10.040.depot

b swinstall -s 
<ExtractDir>/HPOvJxpl-03.10.040.depot

c swinstall -s <ExtractDir>
/HPOvJREB-01.05.002.depot

d swinstall -s <ExtractDir>
/HPOvDshRhvCo-02.10.000.depot

e swinstall -s <ExtractDir>
/HPOvDshSNAdapt-02.10.000.depot

4 At the command prompt, run the file ovdsnpwdchg.sh from /opt/OV/bin. The HP 
Operations Dashboard Service Navigator Adapter Configuration dialog box opens.

5 Enter the user name and password for HP Service Navigator application server, click 
Save, and then click Exit.

6 To modify the HP Service Navigator adapter configuration, edit the following properties 
file:
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/var/opt/OV/conf/ovdshsnadapter/OVSNAdapterConfig.properties

7 At the command prompt, run the file ovsn_adapter.sh from the location /opt/OV/bin. 
The adapter starts running as a daemon.

On Solaris:

The procedure to install the adapter on a Solaris system is same as on a HP-UX system. Make 
sure that you extract the following files from the HPOvDshAdapter-SunOS5.7.tar.gz 
file by using the pkgadd -d command:

1 HPOvXpl-03.10.040.sparc

2 HPOvJxpl-03.10.040.sparc

3 HPOvJREB-01.05.002.sparc 

4 HPOvDshRhvCo-02.10.000.sparc

5 HPOvDshSNAdapt-02.10.000.sparc

Attribute Default Value Description

MESSAGE_COUNT 5 The maximum number of HP Operations 
Operations messages you want to view for 
an HP Service Navigator service 
element.The MESSAGE_COUNT is the 
maximum number of messages to be 
collected by the RealTime Health View 
server at every polling interval.

OVSN_SERVICE_TREE_DEPTH 3 The depth of the imported HP Service 
Navigator service tree. This is useful when 
you want to control the depth of the
HP Service Navigator service tree, which is 
displayed in the RealTime Health View 
composer.

DATABASE_HOSTNAME The name of the system on which database 
is present.

DATABASE_PORT_NUMBER The port number on which database 
service is running.

DATABASE_NAME The name of the database instance.

Restart the adapter every time you edit the OVSNAdapterConfig.properties 
file.
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Installing the Adapter for HP Operations Manager for Windows

System Requirements

In order to install the adapter successfully, the target management station must meet the 
following minimum system requirements.

Installation Tasks

Perform the following steps to install and configure the adapter.

1 Copy the HPOvDshAdapter-WinNT4.0.zip to the HP Operations Manager for Windows 
management station and extract the contents of the file. 

2 Run the extracted files in the following sequence:

a HPOvXpl-03.10.040.msi

b HPOvJxpl-03.10.040.msi

c HPOvJREB-01.05.002.msi

d HPOvDshRhvCo-02.10.000.msi

e HPOvDshOWAdapt-02.10.000.msi

3 To modify the HP Operation Manager for Windows adapter configuration, edit the 
following properties file 
<OvDataDir>\conf\ovdshowadapter\OVOWAdapterConfig.cfg.

4 Start the adapter as a service from the Services window.

Table 6 System Requirements for the Adapter for HP Operations Manager for 
Windows

Software Requirements

Operating System Windows 2003

HP Operations Manager for Windows Versions 7.21 and 7.5

Microsoft .NET framework Version 1.1 or greater

Attribute Default Value Description

hierarchydepth 3 The depth of the imported HP Operation Manager for 
Windows service tree. You can edit this attribute to 
control the depth of the service tree. 

messagecount 5 The maximum number of HP Operation Manager 
messages you want to view for a service element. The 
MESSAGE_COUNT is the maximum number of messages 
to be collected by the RealTime Health View server at 
every polling interval

Restart the adapter every time you edit the OVOWAdapterConfig.cfg file.
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Installing the Adapter for HP Operations Business Process Insight

When you install HP Operations Business Process Insight (BPI), select the Server and 
Modeler or Server Only mode to install the BPI adapter with BPI on your system. The 
following figure displays all available modes of installation in BPI:

Figure 2 HP Operations Business Process Insight Installation Modes

After installing the BPI server with BPI adapter, you need to start the Web Services Provider 
service from the HP OVBPI Administrator Console window. The following figure shows the 
HP OVBPI Administrator Console window:
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Figure 3 OVBPI Administrator Console

You must start the Web Services Provider service from the OVBPI Administrator 
Console to start the BPI adapter.
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Installing the Adapter for HP Operations Manager for UNIX

System Requirements

In order to install the adapter successfully, the target management station must meet the 
following minimum system requirements.

Installation Tasks

On HP-UX:

Perform the following tasks to install and configure the adapter:

1 Copy the file HPOvDshAdapter-HPUX11.0.tar.gz to the HP Operations Manager for 
UNIX management station.

2 Extract the contents of the file to a local subdirectory <ExtractDir>.  

3 At the command prompt, install the extracted files by using the swinstall command. 
Make sure that you install the files in the listed sequence.

a swinstall -s 
<ExtractDir>/HPOvXpl-03.10.040.depot

b swinstall -s 
<ExtractDir>/HPOvJxpl-03.10.040.depot

c swinstall -s <ExtractDir>
/HPOvJREB-01.05.002.depot

d swinstall -s <ExtractDir>
/HPOvDshRhvCo-02.10.000.depot

e swinstall -s <ExtractDir>
/HPOvDshOUAdapt-02.10.000.depot

4 At the command prompt, run the file ovdoupwdchg.sh from /opt/OV/bin. The HP 
Operations Dashboard UNIX Adapter Configuration dialog box opens. 

5 Enter the user name and password for HP Operations Manager for UNIX application 
server, click Save, and then click Exit.

6 To modify the HP Operations Manager for UNIX adapter configuration, edit the following 
properties file:

Table 7 System Requirements for the Adapter for HP Operations Manager for 
UNIX  

Software Requirements

Operating System HP UX 11.11 and HP UX 11.23 PA-RISC, Solaris 8 and 9 
(sparc) 

HP Service Navigator  Versions 8.x.
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/var/opt/OV/conf/ovdshouadapter/OVOUAdapterConfig.properties

7 At the command prompt, run the file ovou_adapter.sh from the location /opt/OV/bin. 
The adapter starts running as a daemon.

On Solaris:

The procedure to install the adapter on a Solaris system is same as on a HP-UX system. Make 
sure that you extract the following files from the HPOvDshAdapter-SunOS5.7.tar.gz 
file by using the pkgadd -d command:

1 HPOvXpl-03.10.040.sparc

2 HPOvJxpl-03.10.040.sparc

3 HPOvJREB-01.05.002.sparc 

4 HPOvDshRhvCo-02.10.000.sparc

5 HPOvDshOUAdapt-02.10.000.sparc

Installing the Adapter for HP Service Center

HP Operations Dashboard provides two adapters for HP Service Center, adpater for HP 
Service Center 6.1 and adapter for HP Service Center 6.2.  Both adapters are local adapters. 
They are installed on the Operations Dashboard RealTime Health View server automatically, 
when you install Operations Dashboard on a system. It is unlike other Operations Dashboard 
adapters, which are installed on their respective management servers.

The adapters for HP Service Center are expected to work with the HP Service Center 6.1 or 
6.2 installed on any platform. However, Microsoft Windows 2003 with Microsoft SQL Server is 
the certified environment.

For more information on how to configure HP Operations Service Center adapter, see 
Configuring the Adapter for HP Service Center on page 41.

Attribute Default Value Description

MESSAGE_COUNT 5 The maximum number of HP Operation 
Manager messages you want to view for an 
HP Operations Manager for UNIX service 
element.The MESSAGE_COUNT is the 
maximum number of messages to be 
collected by the RealTime Health View 
server at every polling interval.

Restart the adapter every time you edit the OVOUAdapterConfig.properties 
file.
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Installing System Tray

System Requirements

In order to install the System Tray tool successfully, the target management station must 
meet the following minimum system requirements.

Installation Tasks

Perform the following steps to install and configure the adapter.

1 Copy the HPOvDshSysTray-WinNT4.0.zip to the client system and extract the contents 
of the file. 

2 Run the extracted files in the listed sequence.

a HPOvXpl-03.10.040.msi

b HPOvJxpl-03.10.040.msi

c HPOvJREB-01.05.002.msi 

d HPOvDshRhvCo-02.10.000-WinNT4.0-release.msi

3 Run HPOvDshSysTray-02.10.000.msi to install System Tray on the client system.

4 After the installation is over, perform the following steps on the client system.

a Click Start->Programs->HP OpenView->Dashboard->Realtime HealthView->Start 
System Tray to start the System Tray tool. The system tray icon appears in Windows 
System tray.

b Right click the system tray icon and select Configure Adapter details... form the pop-up 
menu. The Enter your adapter details dialog box appears.

c Enter the adapter host name where Opearations Dashboard server is installed and 
running.

d Right click the system tray icon and select Login from the pop-up menu to display the 
Login dialog box.

e Enter the User name and password of a dashboard user for which you want to view 
the dashboard status.

Table 8 System Requirements for System Tray tool

Software Requirements

Operating System Windows XP and Windows 2003

System Tray does not support WebLogic Portal server. WebLogic Portal server 
users cannot connect to System Tray to view the dashboard status.
28 Chapter 3



f Right click the system tray icon and select Show Dashboard status form the pop-up 
menu to see the status of the available dashboards.

Adding System Tray to the Windows Startup

You can add system tray icon to the Windows startup so that system tray is started 
automatically when you restart your system.

1 Right click the Programs->HP OpenView->Dashboard->RealTime Health View->Start System 
Tray. 

2 Select Create Shortcut from the pop-up menu. It creates a shortcut of the system tray in 
Programs->HP OpenView->Dashboard->RealTime Health View.

3 Cut or copy this shortcut and paste it in your startup folder. For example, C:\Documents 
and Settings\All Users\Start Menu\Programs\Startup.

Verifying Adapter Installation

To verify that the adapter is installed and running on the management station, complete the 
following steps:

1 Load the following URL in a browser:

http://<hostname>:<port number>/axis/services/<adapter>?wsdl

where <hostname> is the name of the management server, <portnumber> is the port used 
by the adapter, and <adapter> is the web service name of the adapter. The default port 
number and name of each adapter is listed in the following table.

Restart the Dashboard server and System tray if you change the database details 
on the Operations Dashboard server.

Restart the system tray to view the updated dashboard status if you change the 
system tray adapter host name.

You must login before you view the dashboard status.

Adapter Name
Default Port 
Number

Web Service Name of the 
Adapter 

Adapter for 
HP Internet Services

18091 OVISAdapter

Adapter for 
HP Service Desk

18092 OVSDAdapter

Adapter for 
HP Service Navigator

18093 OVSNAdapter

Adapter for 
HP Operations Manager for Windows

18094 OVOWAdapter
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If the adapter is installed and running, a page similar to the following appears.

Adapter for 
HP Operations Business Process 
Insight

44014 OVBPIAdapter

Confirm this service name from 
the server-config.wsdd file 
located at 
<OvDataDir>\data\conf\bia on 
the OVBPI server.

Adapter for 
HP Service Centre

12670 Not Applicable

Adapter for 
HP Operations Manager for UNIX

18097 OVOUAdapter

Adapter for 
RealTime Health View System Tray

8090 OVDAdapter

After you install the adapters on the target management stations, you can configure 
RealTime Health View to use the adapters. For more information about configuring adapters 
by using the Dashboard Configuration Manager, see Add and Configure Adapters on page 40.

Adapter Name
Default Port 
Number

Web Service Name of the 
Adapter 
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Changing Adapter Port Numbers

If the default port of an adapter is used by some other application, you must change the port 
number of the adapter on the management server. 

On Windows:

Perform the following steps on the management server to change the adapter port number on 
Windows.

1 On the management server, open the the Registry Editor window.

2 In the navigation pane, expand HKEY_LOCAL_MACHINE → System → ControlSet001 → 
Services → <adapter service name>, where <adapter service name> is the name of the 
adapter service in Windows.

3 Click Parameters from the expanded list to display a list of parameters in the details pane.
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4 In the details pane, double-click Start Param Number 1. The Edit String dialog box opens.

5 In the Value data text box, enter an available port number, and then click OK.

On HP-UX and Solaris:

Perform the following steps to change the adapter port number on HP-UX.

1 Go to the location /opt/OV/bin

2 To change the existing port of the adapter for HP Service Navigator, run the following 
command at the command prompt:

./ovdsnadapterportchg.sh <port number>

where <port number> is an available port.

3 To change the existing port of the adapter for HP Service Desk, run the following 
command at the command prompt.

./ovdsdadapterportchg.sh <port number>

where <port number> is an available port.

Uninstalling Adapters

Perform the following steps to uninstall an adapter.

On Windows:

1 Go to Start → Settings → Control Panel.

2 Click Add/ Remove Programs. The Add/ Remove Programs window opens.

3 Remove the adapter from the Add/ Remove Programs list.

To change the port number of the BPI Adapter, go to the Port Numbers option from 
the OVBPI Administrator Console and change the port number of the Web 
Services Provider service. You should stop all services before changing the port 
number and after changing the port number, restart all services.
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On HP-UX: 

In an HP-UX environment, run swremove command at the command prompt to uninstall the 
adapter.

On Solaris: 

In a Solaris environment, run pkgrm <adapter name> command at the command prompt to 
uninstall the adapter.
Installing and Configuring Adapters 33



Importing Large Service Trees

By default, the adapters are capable of importing service trees of approximately 1 MB in size 
and three levels of depth. You can customize the number of levels from 1 to 20 by editing the 
adapter properties file. However, if the size of the service tree is greater than 1 MB and the 
number of levels is set to greater than 20, RealTime Health View may fail to import service 
definitions from the source management station. To counter this limitation, you must increase 
the Java Virtual Machine (JVM) heap size of the management stations where adapters are 
installed.

Increase the JVM Heap Size

To increase the JVM heap size of an adapter, perform the following steps:

On Windows:

1 Stop the adapter service from the Services window.

2 Open the Registry Editor window.

3 To increase the JVM heap size of the adapter for HP Service Desk, perform the following:

a In the left pane, expand HKEY_LOCAL_MACHINES → System → ControlSet001 → 
Services → HP OpenView Dashboard Service Desk Adapter, and then click Parameters.

b In the right pane, double-click JVM Option Number 6. The Edit String dialog box 
appears.

c In the Value Data text box, change the value from -Xmx256m to -Xmx512m and click OK.

4 To increase the JVM heap size of the adapter for HP Operations Internet Services, 
perform the following:

a In the left pane, expand HKEY_LOCAL_MACHINES → System → ControlSet001 → 
Services → HP OpenView Dashboard Internet Services Adapter, and then click Parameters.

b In the right pane, double-click JVM Option Number 6. The Edit String dialog box opens.

c In the Value Data text box, change the value from -Xmx256m to -Xmx512m and click OK.

5 To increase the JVM heap size of the adapter for HP Operation Manager for Windows, 
perform the following:

a In the left pane, expand HKEY_LOCAL_MACHINES → System → ControlSet001 → 
Services → HP OpenView Dashboard Operations Windows  Adapter and click Parameters.

b In the right pane, double-click JVM Option Number 8. The Edit String dialog box opens.

c In the Value Data text box, change the value from -Xmx256m to -Xmx512m and click OK.

6 Restart the adapter service from the Services window.

On HP-UX and Solaris:

1 Stop the adapter daemon.

2 To increase the JVM heap size of the adapter for HP Service Navigator, perform the 
following steps:

a Open the file ovsn_adapter.sh from /opt/OV/bin/
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b Go to the line:
nohup $ADAPTER_HOME/nonOV/jre/b/bin/java -cp $CP $SYSPROPS -Xms128m 
-Xmx256m org.apache.axis.transport.http.SimpleAxisServer -p $PORT >> 
$LOGFILE 2>&1 &

c Change -Xmx256m to -Xmx512m

3 To increase the JVM heap size of the adapter for HP Service Desk, perform the following 
steps:

a Open the file ovsd_adapter.sh from /opt/OV/bin/

b Go to the line:
nohup $ADAPTER_HOME/nonOV/jre/b/bin/java -cp $CP $SYSPROPS -Xms128m 
-Xmx256m org.apache.axis.transport.http.SimpleAxisServer -p $PORT >> 
$LOGFILE 2>&1 &

c Change -Xmx256m to -Xmx512m

4 Restart the adapter daemon.
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4 Configuring RealTime Health View
HP Operations Dashboard RealTime HealhView provides you with a Configuration Manager 
that you can use to customize the servers, adapters, and databases that RealTime Health 
View uses. This chapter contains information about the following topics:

• Dashboard Configuration Manager on page 37

• Configuring RealTime Health View on page 38

• Configuring a Custom Database on page 44

• Configuring BEA WebLogic as Portal Server on page 54

Dashboard Configuration Manager

After installing HP Operations Dashboard RealTime Health View, you can configure it by 
using the Dashboard Configuration Manager. Dashboard Configuration Manager enables you 
to enter or modify configuration parameters and to start or stop the RealTime Health View 
server. You can use the HP Operations Dashboard Configuration Manager to configure 
options on the following tabbed pages:

• Server tab: enables you to view and modify server-related information such as port 
number and polling interval. 

• Database tab: enables you to view and modify database configuration information, such 
as database type, database driver name, database driver type, and so on.

• Adapter tab: enables you to view the list of configured adapters. You can also add or 
remove adapters.

• Dashboard tab: enables you to view the list of users and available dashboards and to 
assign dashboards to a particular user.

• Administration tab: enables you to start and stop the RealTime Health View servers.

For information on configuring dashboards, see the chapter Creating Dashboards on page 57.
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Configuring RealTime Health View

To configure Operations Dashboard RealTime Health View, complete the following sequence 
of tasks:

1 Launch the Configuration Manager

2 Configure Server Properties

3 Configure Database Properties

4 Add and Configure Adapters

5 Start Servers

Task 1: Launch the Configuration Manager

From the Start menu, click Programs→HP OpenView→Dashboard→RealTime Health View→ 
Configuration Manager. The Dashboard Configuration Manager opens.

Task 2: Configure Server Properties

1 The Dashboard Configuration Manager opens to the Server tab. Notice the default values 
and prepare to configure the server based on the requirements of your environment.

If the Configuration Manager is already running, the following error message 
appears:

An instance is already running.

If this message appears, you must delete the file gui.lock from the 
<OvInstallDir>\bin directory, and then relaunch the Configuration Manager.
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2 On the Server tab, set and modify the following server properties:

• Server: is the host name or IP of the system on which Dashboard is installed. This 
value is always localhost because the Configuration Manager and the Dashboard 
Server are present on the same system.

• Port: the port number used by the RealTime Health View application. By default, it is 
set to 55000. If the default port number is already in use by another application, enter 
an available port number.

• Mode: sets the mode in which Dashboard Server works. To get the real time data 
from the management servers and datasources, you must select live mode. RealTime 
Health view also supports file mode for the demonstration purpose.

• Polling interval: sets the frequency of polling data from the management servers. 
The default polling interval is 5 minutes. You can change the polling interval.

3 After you finish configuring the server properties, click Save.

Task 3: Configure Database Properties

In order to connect to a database, you must first configure the database properties. You can 
use the default database created during installation of RealTime Health View or use a custom 
database.

To configure the database properties, perform the following steps.

1 Select the Database tab.

2 Unless you plan to use a custom database, keep the default settings, including the blank 
fields User Name and Password, and click Save.

For information about using a custom database, see the section Configuring a Custom 
Database on page 44.
Configuring RealTime Health View 39



Task 4: Add and Configure Adapters

In order to retrieve data, you must first add and configure adapters. To add and configure 
adapters, perform the following steps:

1 Select the Adapter tab.
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2 Click Add. The Enter adapter details dialog box opens.

3 From the Product Name list, select the name of the adapter.

4 In the Host box, enter the hostname or IP address of the system on which the adapter is 
installed.

5 In the Port box, enter the port number used by the adapter.

6 Click OK.

7 To add more adapters, repeat steps 2 to 6.

Configuring HP Service Center adapter is different from how to configure other OVD 
adapters. See Configuring the Adapter for HP Service Center on page 41 for more 
information.

Configuring the Adapter for HP Service Center

The adapter for HP Service Center 6.1 and adapter for HP Service Center 6.2 can recieve data 
from HP Service Center 6.1 and HP Service Center 6.2 management servers respectively. You 
cannot configure one adapter for more than one HP Service Center management servers. 

Before configuring the adapter for HP Service Center, you need to configure the 
ProblemManagement web service by using the Service Center Client. To configure the 
ProblemManagement web service, follow these steps.

1 Open the Service Center Client.

2 Click Toolkit->WSDL Configuration. The External Access Definition page appears.

While adding adapter for HP Operations Business Process Insight, ensure that Service Name 
is OVBPIAdapter. You can confirm this service name from the server-config.wsdd file located 
at <OvDataDir>\data\conf\bia on the BPI server.
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3 Type ProblemManagement in the Service name box and click Search. The External Access 
Definition: rootcuase page appears.

4 Click Data Policy to display a list of all attributes.

5 Type false in the Exclude column for the following attributes.

• brief.description

• expected.resolution.time

• id

• logical.name

• open.time

• update.time

6 Change the API Data type to DateTimeType for the following attributes.

• expected.resolution.time

• open.time

• update.time

7 Click OK.

After configuring the ProblemManagement web service, you can configure the HP Service 
Center adapter by using Operations Dashboard Configuration Manager. To add and configure 
the adapter for HP Service Center:

1 Select the Adapter tab.

2 Click Add. The Enter Adapter Details dialog box opens.

3 Expand the Product Name list. Select HP Service Center 6.1 or HP Service Center 6.2 
from the displayed list. 
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4 As you select the HP Service Center 6.1 or 6.2, the Enter Adapter Details dialog box 
appears as follows.

5 In the Host box, enter the IP address of the system on which HP Service Center 6.1 or 6.2  
is installed.

6 In the Port box, enter the port number on which the HP Service Center management 
server accepts the Simple Object Access Protocol (SOAP) calls.

7 In the User Name box, enter a valid user name and password. HP Service Center requires 
each Web service request to provide a valid user name and password. The user must have 
the SOAP API capability word to access the Web services API.

8 Click Ok.
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Task 5: Start Servers

To start the RealTime Health View server and the portal server, perform the following steps:

1 Select the Administration tab.

2 Click the Start buttons to start the RealTime Health View server and portal server. Click 
Start... to start both the servers together.

Configuring a Custom Database

You can configure Dashboard Configuration Manager to connect to a database other than the 
default database. The custom databases can be

• Microsoft SQL Server 2000 Enterprise Edition database

• Microsoft SQL Server 2005 Desktop Engine database

• Oracle 9i database

Configure RealTime Health View to Use a Microsoft SQL Server Database

Instead of using the default database, you can use a Microsoft SQL database as the back-end 
database.You can either use a database available in your local system, or a database in a 
remote system in the network domain.
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Create the Microsoft SQL Server Database

Perform the following steps to create a Microsoft SQL Server database:

1 From the Start menu, click Programs→Microsoft SQL Server→Enterprise Manager. The 
Enterprise Manager window opens.

2 In the navigation pane, expand the Microsoft SQL Servers → SQL Server Groups directory to 
view a list of available servers.

3 Expand the server on which to create the database.

4 In the navigation pane, double-click the Databases folder to view a list of available 
databases on the selected server.
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5 From the Tools menu, click SQL Query Analyzer. The SQL Query Analyzer window opens.

6 From the File menu, open the query file eddb_script.sql from the location 
<OvInstallDir>\misc\dashboard\rhview\server. The contents of the script file 
appear in the editor.

7 From the Query menu, click Execute. The ovddb database is created.

8 If you want to use Windows authentication, you do not need to create a login or password. 
If you want to use SQL authentication, you must create a login. Perform the following 
steps to create a login for ovddb.

a In the navigation pane of the Enterprise Manager, expand the Security directory.

b Right-click the Logins icon, and then select New Login. The SQL Server Login 
Properties - New Login dialog box opens. 

c In the Name box, enter a name for the login. For example, test.

d Select the SQL Server Authentication option.

e In the Password box, enter a password for the new login.
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f From the Database list, select the database that you created in step 7.

g Keep the Language setting default, and then click OK. The Confirm Password 
message appears.

h Enter the password, and then click OK. The login is created and now appears in the 
Enterprise Manager.

i Right-click the newly created login, and then select Properties. The SQL Server Login 
Properties dialog box opens.

j Click the Database Access tab.

k Select the ovddb check box to specify which database the newly created login can 
access, select the db_owner check box, and then click OK.

Configure RealTime Health View for Microsoft SQL Server Database

After you set up the Microsoft SQL Server database and driver, perform the following steps to 
use a custom Microsoft SQL Server as a back-end database.

1 Select the Database tab. The Database Configuration dialog opens.

2 Select the option Microsoft SQL Server from the Database list.

3 Specify the following database configuration parameters (see Table 9):

• Driver Type

• Driver Name

• URL 

• Username

• Password 

4 Click Save to save the database configuration.

For more information, see the documentation provided with Microsoft SQL Server.
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Table 9 Configuration Parameters for Microsoft SQL Server Databases

Seri
al
No. Driver Type Driver Name URL Login Details

1.0 Inet Type 4 
Driver 
(Windows 
Authentication 
for Named 
Instance)

com.inet.pool.Po
olDriver

For local database —
jdbc:inetpool:inetdae7://
<localhost>/pipe/
MSSQL$<instance 
name>/sql/
query?database=<datab
ase name>
where <database name> is 
the name of the database 
and <instance name> is 
the name of the database 
instance.

Leave the User 
name and 
Password fields 
blank.

For remote database —
jdbc:inetpool:inetdae7:// 
<hostname>/pipe/
MSSQL$<instance 
name>/sql/
query?database=<datab
ase name>
where <database name> is 
the name of the database, 
<hostname> is the 
hostname or IP address of 
the system, and <instance 
name> is the name of the 
database instance.

Leave the User 
name and 
Password fields 
blank. For a 
remote database, 
Windows 
Authentication for 
Named Instance 
works only if the 
host system of the 
remote database 
and the RealTime 
Health View 
server are in the 
same domain.
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2.0 Inet Type 4 
Driver 
(Windows
Authentication)

com.inet.pool.Po
olDriver

For local database —
jdbc:inetpool:inetdae7://
<localhost>/pipe/
sqlquery?database=
<database name>
where <database name> is 
the name of the database

Leave the User 
name and 
Password fields 
blank.

For remote database —
jdbc:inetpool:inetdae7://
<hostname>/pipe/
sqlquery?database=
<database name>
where <database name> is 
the name of the database
and <hostname> is the 
hostname or IP address of 
the system.

Leave the User 
name and 
Password fields 
blank. For a 
remote database,
Windows 
Authentication 
works only if the 
host system of the 
remote database 
and the RealTime 
Health View 
server are in same 
domain.

Table 9 Configuration Parameters for Microsoft SQL Server Databases

Seri
al
No. Driver Type Driver Name URL Login Details
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3.0 Inet Type 4 
Driver (SQL 
Authentication)

com.inet.pool.Po
olDriver

For local database —
jdbc:inetpool:inetdae7:
<localhost>:1433?databa
se=<database name>
where <database name> is 
the name of the database

Enter the User 
name and 
Password to access 
the database 
<database name>.

For remote database —
jdbc:inetpool:inetdae7:
<hostname>:1433?databa
se=<database name>
where <database name> is 
the name of the database
and <hostname> is the 
hostname or IP address of 
the system.

Enter the User 
name and 
Password to access 
the database 
<database name>.

4.0 Inet Type 4 
Driver (SQL 
Authentication 
for Named 
Instance)

com.inet.pool.Po
olDriver

For local database —
jdbc:inetpool:inetdae7:
<localhost>/<instance 
name>?database=<datab
ase name>
where <database name> is 
the name of the database 
and <instance name> is 
the name of the database 
instance.

Enter the User 
name and 
Password to access 
the database 
<database name>.

For remote database —
jdbc:inetpool:inetdae7: 
<hostname> /<instance 
name>?database=<datab
ase name>
where <database name> is 
the name of the database, 
<hostname> is the 
hostname or IP address of 
the system, and <instance 
name> is the name of the 
database instance.

Enter the User 
name and 
Password to access 
the database 
<database name>.

Table 9 Configuration Parameters for Microsoft SQL Server Databases

Seri
al
No. Driver Type Driver Name URL Login Details
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Configure RealTime Health View to Use an Oracle Database

Instead of using the default database, you can use an Oracle database as the back-end 
database.You can either use a database available in your local system, or a database in a 
remote system in the network domain.

Create the Oracle Database

Perform the following steps to create an Oracle database:

1 Launch SQL Plus. You can also perform the following steps by using the Enterprise 
Manager.

2 Create the tablespace into which you will load the tables for RealTime Health View. Run 
the following script at the SQL command prompt:

CREATE TABLESPACE ovddb
DATAFILE '<Oracle Install Directory>\oradata\<test>\ovddb.dbf'
SIZE 10M
AUTOEXTEND ON NEXT 10M
MAXSIZE unlimited;

ovddb is the name of the tablespace. You must enter the DATAFILE location according to 
your oracle installation location. 

<Oracle Install Directory> is the directory where Oracle is installed in the system.

<test> is the name of the instance or System Identifier (SID).

You must reference this name while creating the database user. This command creates 
10MB of tablespace, and then automatically extends the tablespace as needed.

3 Create the user profile that RealTime Health View will use. Run the following script at 
the SQL command prompt:

CREATE USER <user_name> PROFILE DEFAULT
IDENTIFIED BY <password> DEFAULT TABLESPACE ovddb
ACCOUNT UNLOCK;
GRANT CONNECT TO <user_name>;
GRANT RESOURCE TO <user_name>;

This command creates a user in the database. <user_name> is the name of the database 
user.  <password> is the user's password. ovddb is the default tablespace assigned to the 
user. 

4 Log in to Oracle with the newly created user account. To log in, run the following 
command at the SQL command prompt:

CONNECT <user_name>/<password>

5 Create the schema for ovddb. To create the schema, run the following script at the SQL 
command prompt:

@<path>/eddb_orascript_ddl.sql

<path> is the full path to the file eddb_orascript_ddl.sql. If HP Operations 
Dashboard is installed in <OvInstallDir>, the <path> is 
<OvInstallDir>\misc\dashboard\rhview\server

The eddb_orascript_ddl.sql script creates tables and inserts them into the user's 
default tablespace. If you do not want to assign the tablespace of ovddb to be the 
user's default tablespace, you must edit the script.
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6 If no error messages appear, the database tables are successfully created in the database 
ovddb.

7 Insert the required default data in ovddbbeta2. To insert the default data, run the 
following script at the SQL command prompt:

@path/ eddb_orascript_dml.sql

<path> is the full path to the file eddb_orascript_ddl.sql. If HP Operations 
Dashboard is installed in <OvInstallDir>, the <path> is 
<OvInstallDir>\misc\dashboard\rhview\server.

8 If no error messages appear, the required default values are inserted in ovddbbeta2.

Set up the Oracle Driver

To be able to use Oracle as a back-end database, you also need to set up the Oracle driver. 
Perform the following steps to download and set up the Oracle driver:

1 Download the Oracle Type 4 Thin Driver – ojdbc14.jar from the following location.

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/
jdbc9201.html

2 Copy the ojdbc14.jar file to the following two locations.

• <OvInstallDir>\nonOV\dashboard\rhview

• <OvInstallDir>\nonOV\dashboard\jetspeed\2.1\shared\lib

Configure RealTime Health View for Oracle Database

After you set up the Oracle database and driver, perform the following steps to use Oracle as a 
back-end database:

1 Select the Database tab.

2 From the Database list, select Oracle.

3 Specify the following database configuration parameters (see Table 10):

— Driver Type: select the JDBC database driver from the list of available drivers. Select 
Oracle Type 4 Thin Driver- ojdbc14.jar.

— Driver Name: default is set to oracle.jdbc.driver.OracleDriver.

— URL: type the JDBC URL. For example, jdbc:oracle:thin:@gspint7:1521:<Host 
String>=ovddb. Here, Host String is the instance or SID that was created in step 2 
on page 51. 

— Username: type the username for accessing the database that was created in step 2 on 
page 51.

— Password: type the password for accessing the database that was created in step 2 on 
page 51. 

4 Click Save to save the database configuration.

For more information, see the Oracle documentation.

If you change the database from Microsoft SQL Server to Oracle, or the reverse, you must 
restart the dashboard and portal servers from the Dashboard Configuration Manager for the 
changes to take effect.
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Table 10 Configuration Parameters for Oracle Database

Seria
l
No. Driver Type Driver Name URL

Login
Details

1.0 Oracle Type 4 
Thin Driver

oracle.jdbc.driv
er.OracleDriver

For local database —
jdbc:oracle:thin:@
localhost:<portname>
:<Host String>
where <portname> is the port 
name of Oracle database and 
<Host String> is the name of 
the System Identifier created 
in step 2 on page 51.

Enter the User 
name and 
Password of the 
Oracle database.

For remote database —
jdbc:oracle:thin:@
<hostname>:<portname>
:<Host String>
where <hostname> is the 
name of the system, 
<portname> is the port name 
of Oracle database, and <Host 
String> is the name of the 
System Identifier created in 
step 2 on page 51.

Enter the User 
name and 
Password of the 
Oracle database.
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Configuring BEA WebLogic as Portal Server

RealTime Health View supports BEA WebLogic as portal server. Jetspeed is bundled with 
RealTime Health View and installed automatically during installation. If you want to use 
BEA WebLogic as the portal server for RealTime Health View, you must have BEA WebLogic 
8.1 Workshop installed on the system where RealTime Health View is installed.

To configure BEA WebLogic to be used as a portal server, perform the following.

1 Create a Portal Domain

2 Deploy the RealTime Health View Portlet Application to BEA WebLogic

Task 1: Create a Portal Domain

1 From the Start menu, click Programs→BEA WebLogic Platform 8.1→Configuration Wizard. 
The BEA WebLogic Configuration Wizard opens.

2 Select the Create a New WebLogic Configuration option, and then click Next.

3 From the Templates pane, select Basic WebLogic Portal Domain, and then click Next. The 
Choose Express or Custom Configuration dialog box opens.

4 Select the Express option, and then click Next.

5 Enter a name and password in the User name and User password fields, and then click 
Next. The Configure Server Start Mode and SDK dialog box opens.

6 Keep the default settings, and then click Next. The Create WebLogic Configuration dialog 
box opens. 

7 If desired, change the configuration name, and then click Create.

8 Click Done.

Task 2: Deploy the RealTime Health View Portlet Application to BEA WebLogic

Perform the following tasks to deploy RealTime Health View portlet application to BEA 
WebLogic.

1 Create a Portal Application

2 Create a Web Application

3 Deploy the Application

Create a Portal Application

1 Start BEA WebLogic Workshop 8.1.

2 Click File→New→Application. The New Application dialog box opens.

3 Select Portal Application.

4 In the Directory box, enter the location in which you want to store the application.

If you choose to use a custom database, you must copy the DATABASE_DETAILS.properties 
file from the location <OvDataDir>\conf\dashboard\rhview\common to 
<BEA-HOME>\user_projects\<Application Name>\<Project 
Name>\WEB-INF\classes
where <Application Name> is the name of the application created in step 5 on page 55 and 
<Project Name> is the name of the project imported in step f on page 55.
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5 In the Name box, enter ovdportal as the name of the application.

6 Make sure that the data in the Server field accurately points to the location of the 
config.xml file for the newly created portal domain. See Create a Portal Domain on 
page 54 for information on creating a portal domain in BEA WebLogic.

7 Click Create. The new portal application opens in the Application pane.

Create a Web Application

1 Copy the ovdportal_weblogic.war file from <OvInstallDir>\java to a local directory.

2 Extract the contents of the file. To extract the contents, go to the location you copied 
ovdportal_weblogic.war, and then run the command jar -xvf 
ovdportal_weblogic.war.

3 Import the project to WebLogic Workshop  8.1. To do this, perform the following steps.

a In WebLogic Workshop 8.1, click File→Import Project. The Import Project - New Project 
dialog box opens.

b In the navigation pane, select the portal. The list of web projects appears in the details 
pane.

c Select the portal web project. 

d Click Browse, and then navigate to the directory in which you want to stage the 
RealTime Health View portlet application.

e Select the Copy into Application directory check box.

f The name that shows in the Name field is the name that will appear in the BEA 
WebLogic configuration tools.Verify that this is the correct project name, or change 
the name if necessary, and then click Import. A popup message asking you to confirm 
the update to the Workshop appears.

g Click Yes.

Deploy the Application

1 Click Build→Build EAR. This command creates the EAR file <application name>.ear 
where <application name> is the name of the application. 

2 Deploy the EAR file in WebLogic.

For more information, see the documentation provided with BEA WebLogic Workshop 8.1.
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5 Creating Dashboards
You can use the HP Operations Dashboard RealTime Health View composer module to design 
the portal views that your end users see, including customized dashboards. This chapter 
contains the following topics:

• Dashboard Composer on page 57

• Creating a New Dashboard on page 59

• Building the Dashboard Hierarchy on page 68

• Generating the Dashboard on page 76

• Making a Backup of Dashboard Definitions on page 77

Dashboard Composer

The Dashboard Composer enables you to do the following:

• Import services from management applications and other data sources such as HP 
Operations Internet Services, HP Service Navigator, and HP Service Desk. You can also 
import SQL data sources by using queries.

• Create, modify, or remove dashboard views and define service groups. This enables you to 
display high-level service views grouped by geographies, business units, organizational 
units, and so on.

• Deploy any newly designed dashboard view so that it displays as a complete portal-based 
web site. 

The Dashboard Composer shows you information at three levels: navigator, summary, and 
view.
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Figure 4 Composer for RealTime Health View

• Navigator pane: provides navigation to existing dashboards, data sources, and 
standalone services.

— Dashboard: this element contains existing dashboards. If you expand this element, 
you can see the available dashboards.

— Data Sources: this element has two sub-elements—HTTP and SQL. RealTime Health 
View imports data from remote servers with the help of adapters. It can also collect 
data from a  SQL Server (available in the network), or an HTTP web address. These 
SQL Servers and HTTP servers are called data sources. You can expand each element 
to see the available data sources configured inside the group.

— Standalone Services: this displays the list of underlying services imported from 
management servers. It also lists the user-defined data sources that are configured for 
status calculation.

• Summary pane: displays details of a selected element in the navigation pane. 
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Figure 5 Summary Pane

If you select a particular dashboard, imported service, or data source in the navigation 
pane, the summary pane displays the following details.

— Type: the selected element type (for example, dashboard, HTTP data source, or SQL 
data source).

— Name: name of the element.

— Deployment Status: deployed or not deployed.

— Description: description of selected element.

— Last saved: date and time when the element was saved

• View pane: displays visual data about selected dashboards or data sources.

Creating a New Dashboard

To create a new dashboard, perform the following steps based on your requirements and the 
type of dashboard that you want to build:

1 Import Service Definitions on page 59

2 Create Data Sources on page 60

3 Create a New Dashboard on page 66

Import Service Definitions

Perform the following steps to import service definitions from adapters.

1 On the menu bar, click Services → Import Service Definitions. The Import Services box 
opens displaying the list of available adapters.

2 Select the adapters that you want to use, and then click OK. The selected adapters are 
imported to the composer.

3 On the navigator pane, click and expand Standalone Services → Imported Services. The list 
of imported adapters appears.
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4 You can click on an individual adapter to see the list of services available with each 
adapter.

Create Data Sources

If you do not need to retrieve data from SQL or HTTP data sources, skip to the next section. 

• Edit the Data Source Properties Files on page 60 

• Create an HTTP Data Source on page 61

• Create a SQL Data Source on page 63

Edit the Data Source Properties Files

Before you create a data source, you must make sure that the following prerequisites are met.

1 If you want to create an HTTP data source, you must edit the 
HTTPDataSource.properties files with the proxy settings of your browser. Perform the 
following steps to edit HTTPDataSource.properties files.

a Open HTTPDataSource.properties files from the locations 
<OvDataDir>\conf\dashboard\rhview\composer and 
<OvDataDir>\conf\dashboard\rhview\server.

b Edit the following lines in both the files to change the proxy server name and the port 
number:

proxyserver=abc-proxy.xyz.hp.com
proxyserverport=8021

2 If you want to create a SQLDatasource, perform the following steps to edit 
SQLDataSource.properties files.

a Open the SQLDataSource.properties file from the location 
<OvDataDir>\conf\dashboard\rhview\server

b Change the number of rows to be displayed on the portal from the data extracted by 
using the SQL data source. In the following line, change '0' to the number of lines that 
you want to display on the portal: Response_Truncation=0

3 If you want to create an HTTP data source or an SQL data source for status calculation, 
you must have Perl installed on RealTime Health View system. Also, you must edit 
oved-repository.cfg file with the location details of Perl. To edit 
oved-repository.cfg:

a Open the oved-repository.cfg from 
<OvDataDir>\conf\dashboard\rhview\server.

b On the UDDS tab, set EXEC_PATH to the location of Perl, and SUFFIX to.pl.

You can verify whether the service definitions have been imported or not from the 
status bar of the Composer window. It displays a message, Service imported if the 
service is imported successfully. Otherwise, it shows an error message, Error 
occured during service synchronization.

If the default value zero is used, then RealTime Health View server collects all the 
rows available for that data source. If the data stack is too large, then an out of 
memory error may occur.
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For example:

[udds]
EXEC_PATH=C:\Perl\bin\perl.exe
SUFFIX=.pl.

Create an HTTP Data Source

You can create three different types of HTTP data sources—configured URL, raw data, and 
status calculation. Perform the following steps to create an HTTP data source.

1 In the navigator pane, right click Data Sources, and then click New → Http datasource. The 
HTTPUserDefinedService dialog box opens.
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2 In the HTTPUserDefinedService dialog box, enter the name and description of the data 
source under the Datasource Identity tab.

3 Select the Proxy check box on the Datasource Properties tab to enable connection through 
the proxy server. If you want to connect to an intranet address, you do not need to select 
this.

4 Perform the following to configure the HTTP data source as a configured URL.

a  Select Configured URL from the Runtime Data Type list.
62 Chapter 5



b In the Configured URL Details section, enter the name of the URL in the Label box.

c In the same section, enter a web address in the URL box; save it; and then click Test & 
Add. The URL is added to the Configured URL Details list. You can add more than one 
URL. This URL appears in the dashboard portal as a hyperlink.

5 Perform the following steps to configure the HTTP data source as raw data.

a Select Raw Data from the Runtime Data Type list.

b In the Datasource Information section, enter the name of the URL in the Label box.

c In the same section, enter a web address in the URL box, and then click Test. If the 
URL is correct, a confirmation pop-up appears. The content of the page linked to this 
URL appears in a portlet in the dashboard portal.

6 Perform the following steps to configure the HTTP data source as a status calculation.

a Enter data in the Label box and the URL box in the Datasource Information section.

b Paste a Perl script in the Transformation Script field. For more information, see the 
Guidelines for Writing a Data Source Transformation Script.

Create a SQL Data Source

Perform the following steps to create a SQL data source.

1 In the navigator pane, right click Data Sources, and then click New → Sql datasource. The 
SQLUserDefinedervice dialog box opens.

2 On the Datasource Identity tab, enter the name and description of the data source.

3 On the SQL Details tab, enter the name of the data source in the Label box.

4  Check the System DSN check box.

Web pages with dynamic HTML content may not be displayed properly as raw 
data.
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5 In the DSN Name field, enter the DSN name of the database that you wish to connect to 
the dashboard.

6 Enter the username and password in the text fields. These will be used to access the 
database.

7 If you select Raw Data in the Runtime Data box, do the following:

a Enter a SQL statement in the Query field.

b Click the Save All icon.

c Click Test to verify that you can access the database.

8 If you select Status Calculation in the Runtime Data box, you must enter a Perl script in 
the Transformation Script field. For more information, see the Guidelines for Writing a 
Data Source Transformation Script.  

If you create DSN by using Windows authentication, you do not need to enter a 
username or password.  

Field Name Sample Value

In General Information section

Label SQL my Table

DSN Name myDSN
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User name username

Password password

In Datasource Details section

Runtime Data Type Raw data or Status Calculation

Query Select * from myDbTable
Enter this only when Runtime Data Type is 
Raw Data. Otherwise, leave this field blank

Transformation Script The Perl script for status calculation.  (Enter 
the Perl script only when Runtime Data Type 
is Status Calculation. Otherwise, this field is 
disabled.)

Field Name Sample Value
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Create a New Dashboard

To create a new dashboard, perform the following steps. 

1 On the menu bar, click File → New → Dashboard.  

Alternatively, in the Navigator pane, right-click the Dashboard folder, and then click New 
→ Dashboard.

The dashboard appears with three tabs — Identity,  Content Selection, and Dashboard 
Editor.

2 On the Identity tab, enter the name and description of the dashboard.
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3 On the Content Selection tab, select the content type for the dashboard portal page. The 
available content types are Service Manager Centric View, Business-IT Centric View, 
IT-Operation Centric View, Global Map View, and IT-Help Desk Centric View. The content 
type you select determined the layout of the generated dashboard portal page.

4 On the Dashboard Editor tab, you should see the newly created dashboard node icon in 
the composer.
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Building the Dashboard Hierarchy

After you create a dashboard, you need to build the hierarchy into which it will fit. This 
hierarchy is also known as a service tree. To build a dashboard hierarchy, perform the 
following steps:

1 Create a Service Group

2 Create a Composite Service

3 Create an Elementary Service

4 Define Relationships Between the Nodes

Task 1: Create a Service Group

A service group is a collection of composite services. After importing service definitions to a 
dashboard, you can create groups with the services imported from management servers. A 
group view usually represents a group of composite services or a sub-grouping of dashboard 
views for facilitating more summarized views. You can create organizational, geographical, or 
analogical grouping of your dashboard by creating service groups.

If you do not want to create a service group, skip this task. Perform the following steps to 
create a service group. 

1 From the menu bar at the top of the composer canvas, click the group icon and drop it on 
the composer canvas. 

2 To name the group, double-click the group node. The Node Properties - Group dialog box 
opens.
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3 In the Name box, enter the name of the group. 

4 In the Description box, enter a brief description of the group. 

5 Perform the following steps if you want to add any data sources to the group node. 

a Click the Data Source tab.

b Click the new service icon. The Select Services for Node pop-up appears.

c Expand the Data Sources folder, and then select the data source you want to add.

d Click OK to return to the Node Properties - Group dialog box.

6 In the Node Properties - CompositeService dialog box, click OK.

Task 2: Create a Composite Service

To create a composite service, perform the following steps.

1 Click the Dashboard Editor tab. From the menu bar, click Tools → Composite Service Node, 
and then click on the dashboard canvas. A new composite service node appears on the 
canvas.
Creating Dashboards 69



2 Double-click the composite service node. The Node Properties CompositeService dialog 
box opens.

3 Click the Node tab, and perform the following.

a In the Name box, enter the name of the composite service. 

b In the Description box, enter a brief description of the composite service. 

c Select AND, OR, or WEIGHT depending on the status calculation requirement.
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4 Click the Service tab.

5 If you do not want to add a service for the node, skip to the next step. To add a service, 
click the Services tab, and then perform the following.
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a On top left corner of the pane, click the new service icon. The Select Services for Node 
pop-up appears.

b Expand Standalone Services → Imported Services to view the list of available service 
definitions imported by various adapters and SLIs.

c Select an available service, and then click OK. The service is added to the composite 
service.

6 Click the Data Source tab. 

7 If you do not want to add a data source to the node, skip to the next step. To add a data 
source, perform the following.
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a Click the new service icon. The Select Services for Node pop-up appears.

b Expand the Data Sources folder, and then select the data source you want to add.

c Click OK.

8 If you do not want to add a look across service, skip this step. Click the Look Across 
Service tab. To add a look across service, perform the following.

a Click the new service icon. The Select Look Across Services for Node pop-up appears.

b Expand the Imported Services folder, and then select an available service.

c Click OK to return to the Node Properties - CompositeService dialog box.

9 In the Node Properties - CompositeService dialog box, click OK.

Task 3: Create an Elementary Service

An elementary service is the basic unit of dashboard hierarchy. You can create independent 
nodes of at the elementary service level, associate the elementary service with some 
underlying services imported from underlying management systems, and then add to a 
composite service node. To create an elementary service, perform the following.

1 Click the Dashboard Editor tab.

2 From the menu bar, click Tools → Service Node, and then click on the dashboard canvas. A 
new elementary service node appears on the canvas.
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3 Double-click the node. The Node Properties - Service dialog box opens.

4 On the Node tab, enter the name and description of the service.

5 If you do not want to add an associated imported service to the node, skip to the next step. 
To add a service, click the Services tab, and then perform the following.

a On top left corner of the pane, click the new service icon. The Select Services for Node 
pop-up appears.

b In the Select Services for Node pop-up, expand Standalone Services → Imported 
Services to see the list of available service definitions imported by various adapters 
and SLIs.

c Select an available service, and then click OK. The service is added to the elementary 
service.

d Similarly you can select a user-defined service. To add a user-defined service, click 
Standalone Services → User Defined  Services.

6 Click the Data Source tab.

7 If you do not want to add a data source for the node, skip to the next step. To add a data 
source, perform the following:

User-defined services are HTTP or SQL data sources with the type set to status 
calculation.
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a Click the new service icon. Select Services for Node pop-up appears.

b Expand the Data Sources folder, and then select the data source you want to add.

c Click OK.

8 Click OK on the Node Properties - Service dialog box.

9 Link the elementary service node to the composite service node by completing the 
following steps.

a On the Dashboard Editor tool bar, click the arrow icon.

b Mouse over the elementary service node that you want to associate with the composite 
service node. A plus (+) sign appears on the elementary service node.

c Click, drag, and drop the plus sign to the composite service node. A link between the 
nodes is established.

Task 4: Define Relationships Between the Nodes

After importing service definitions to a dashboard, you must create a service tree by defining 
relationships between the nodes. To define relationships, perform the following drag-and-drop 
operations.

• Link elementary service nodes to composite service nodes.

• Link composite service nodes to dashboard nodes.

• Link composite service nodes to group nodes as required. 
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• Link data sources to composite service nodes, group nodes, or directly to the dashboard 
node as required.

To link a lower-level node to a higher-level node, perform the following.

1 On the Dashboard Editor tool bar, click the arrow icon.

2 Mouse over the node that you want to associate with a higher-level node. A plus (+) sign 
appears on the lower-level node.

3 Click, drag, and drop the plus sign to the higher-level node.The link between the nodes is 
established. 

Generating the Dashboard

After designing a dashboard and building the service tree, perform the following steps to 
generate it.

1 Click File → Generate Dashboard. The Generate Dashboard dialog box opens.

2 Click Generate Dashboard. After the dashboard is generated, a confirmation message 
appears.

3 After generating the dashboard, launch the Dashboard Configuration Manager, click the 
Dashboard tab, and then associate the generated dashboard to a user. After associating a 
dashboard to a user, you can view the dashboard by logging in to the portal server using 
any web browser.

An elementary service node cannot be directly linked to the dashboard node.
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Making a Backup of Dashboard Definitions

After building a dashboard hierarchy by using the composer, you can save the dashboard’s 
definitions by exporting them to a location on your system, and then reuse them if required. If 
you delete a dashboard from the composer accidentally, you can retrieve the dashboard by 
importing the definitions that you saved.

To export a dashboard’s definitions, perform the following steps. 

1 In the navigator pane of the composer, select the dashboard that you want to export.

2 Click File  → Export Definitions. The Export Definitions dialog box opens.

3 Select the location on your system to which you want to export the definitions, and then 
click Export. The dashboard definitions are saved as a compressed file on your system.

To import a dashboard’s definitions, perform the following steps.

1 Click File  → Import Definitions. The Import Definitions dialog box opens.

2 Click Browse, locate the compressed definitions file on your system, and then click Next.

3 Click Import. The dashboard’s definitions are imported to the composer and appear in the 
Navigator pane.

If adapters to underlying data sources are not running, errors may appear while generating 
the dashboard, but that does not prevent the generation of dashboard in most cases. The 
dashboard is generated if there is no fatal error.
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6 Managing Users
As an administrator, you can create, delete, and manage portal user profiles for RealTime 
Health View. You can perform these tasks from the Operations Dashboard portal.

The Operations Dashboard portal provides a platform to manage user profiles and displays 
the information provided by dashboard models. The portal has two types of login.

• User login: users view the dashboard assigned to the specific user’s profile.

• Administrator login: administrators can add, delete, and manage users. 

Add and Manage Users on Jetspeed

Perform the following steps to manage users in Jetspeed portal.

1 Start the portal server from the Dashboard Configuration Manager, if it is not already 
started.

2 From the Start menu, click Programs → HP OpenView → Dashboard → Launch Operations 
Dashboard. Jetspeed portal’s login page opens.

3 Log in with the administrator's username and password.

4 Click the Security Administration tab. The Security Administration page appears.

5 Click the User Management tab in the Security Administration screen. The User Browser 
and User Detail Information portlets display. 

• User Browser: Displays a list of all portal server users. The admin, devmgr, and guest 
users are default users.

• User Detail Information: Allows you to add or remove users and displays the details of 
selected user.

6 In the User Detail Information portlet, type new user name, password, role and other 
options.

7 Click Add User.

To create or delete a user account from the portal, you must log in to the portal with 
administrator privileges.

 In Jetspeed, the default administrator's user name is admin and password is 
admin.

 The Security Administration tab appears only if you have logged in as the Admin 
user. No other user, even if the user has been assigned the admin role, has 
permissions to set portal security.
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You can see the newly added user account in the User Browser portlet. From the User Detail 
Information portlet, you can make changes in the Attributes profile, Password, Role, and 
Group of the user.

For more information on adding users, roles, and groups in the portal server, refer to the 
Appendix D, Tips for Working with Jetspeed 2.1.1 and BEA WebLogic 8.1, of the Operations 
View Administrator Guide. If you do not have Operations View installed on your system, you 
can view Operations View Administrator Guide at http://ovweb.external.hp.com/lpe/
doc_serv/ site.

Add and Manage Users on BEA WebLogic

The BEA WebLogic portal server is not bundled with RealTime Health View. You must have 
BEA WebLogic 8.1.4 installed in RealTime Health View system to be able to use it. 

See the section Configuring BEA WebLogic as Portal Server on page 54 to configure BEA 
WebLogic.

Perform the following steps to use the BEA WebLogic portal to manage users:

1 Copy the file weblogic.jar from <BEA_HOME>\weblogic81\server\lib to the 
location <OvInstallDir>\nonOv\dashboard\rhview where <BEA_HOME> is the 
location of BEA WebLogic and <OvInstallDir> is the location where RealTime Health 
View is installed.

2 Start a BEA WebLogic portal domain. See the section Create a Portal Domain on page 54 
for information on creating a portal domain on BEA WebLogic. To start the portal domain, 
go to Start → Programs  → BEA WebLogic Platform 8.1 → User Projects →<Portal Domain> 
→Start WLS Server for Portal Domain. 

3 Launch the WebLogic console by loading in the browser the following URL: 

http://localhost:7001/console

4 Log in to the console by using the administrative username and password for <Portal 
Domain>. These were created in step 5 on page 54.

5 In the navigation pane, expand Security → Realms  → myrealms.

6 Click the Users folder. 

7 Click the Configure a New User link to create a user.

8 Enter the user details, and then click Apply.

Map Users to Dashboards in Dashboard Configuration Manager

Perform the following steps to map dashboards to a particular user.

1 Launch the Dashboard Configuration Manager.

In Jetspeed, the user name must not exceed 256 characters.
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2 Select the Dashboard tab.

3 To map the users you created in the WebLogic portal server, perform the following steps.

a Select WebLogic from the Portal Server box. The Select Your Portal Server Setup 
dialog box opens.

b Enter the administrative User name and Password that you created in step 5 on 
page 54 while creating the portal domain.

c Enter 7001 in the Port number box.

d Click OK. The Dashboard Configuration Manager displays a list of available 
dashboards and a list of users created in WebLogic.

4 To map the users created in Jetspeed portal server, select Jetspeed from the Portal Server 
box. 
Dashboard Configuration Manager displays a list of available dashboards and a list of 
users created in Jetspeed.

5 Select a user from the User List.

6 Select the dashboard you want to assign to the selected user.

7 Click the << button to send the selected dashboard to the Dashboard assigned to User 
pane. You can assign an unlimited number of dashboards to any selected user.

8 Restart the server.

9 Click the  >> button to remove dashboards from a user.
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7 Using the Portal
The RealTime Health View portal provides you with a top-level view of service health and 
status to simplify your monitoring and decision making process. The portal consists of several 
portlets, each of which provides a consolidated view of service health and helps you drill down 
to the elementary services managed by 
HP Operations and third-party management systems. 

To be able to use portal to view dashboards, you must have the following.

• A valid username and password to access the portal.

• Dashboards assigned to your user profile.

After you log in to the portal as a user, you can view the health and status of the services at 
multiple levels. You can take a broad-level view first, and then drill down to view additional 
details related to the service. You can drill down from the dashboard level to the elementary 
service level.

The organization of the view depends on the way the dashboard was designed and modeled by 
using the composer. See Creating Dashboards on page 57 for information on creating and 
designing a dashboard.

Launching the Portal

You must launch the portal to view the dashboards. You can use the default Jetspeed portal 
server that is bundled with RealTime Health View, or you can use the BEA WebLogic portal 
server.

Launch Jetspeed Portal

To launch the default Jetspeed portal, perform the following tasks.

1 Start the portal server from the Dashboard Configuration Manager, if it is not already 
started.

2 From the Start menu, click Programs → HP OpenView → Dashboard →Launch Operations 
Dashboard. The Jetspeed portal opens in a web browser.

Alternatively, you can launch Jetspeed by typing the following URL:

http://localhost:18080/jetspeed

3 Log in to the portal with your username and password.
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Launch BEA WebLogic Portal

To use BEA WebLogic as a portal server, you must create a portal application, a web 
application, and a portal domain on a BEA WebLogic server. See the section Add and Manage 
Users on BEA WebLogic on page 80 for information on configuring BEA WebLogic.

To start the BEA WebLogic portal server, perform the following steps.

1 From the Start menu, click Programs → BEA WebLogic Platform 8.1 → User Projects →  
<PortalDomain> →  Start WLS Server for Portal Domain where <PortalDomain> is the name 
of the domain created on the BEA WebLogic server. See the section Create a Portal 
Domain on page 54 for information on creating portal domain on a BEA WebLogic server.

2 On a web browser, load the URL http://localhost:<port>/<Project Name>, where <Project 
Name> is the name of the project imported in step f on page 55.

BEA WebLogic portal appears.

You can log in to the portal with your username and password.

Viewing Dashboards

You can view generated dashboards in the portal. The portal home page displays a list of all 
the dashboards assigned to you. You can drill down and view status at the composite service 
level and at the elementary service level. How the portal view is organized depends on the 
dashboard design.

Portal Home Page

On the portal home page, you can see a list of all the dashboards assigned to you in the My 
Dashboards portlet. If you bring the mouse-arrow near each dashboard, a pop-up appears 
indicating the aggregate health of all the underlying services associated with the dashboard.

Figure 6 List of Dasboards on the Portal Home Page 

To drill down further, click on the dashboard name. The top-level view of the dashboard 
appears. 
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Dashboard Level View

The top-level view of each dashboard gives an overall status of service health. This view 
comprises a set of portlets. The organization of this page is set in the Composer based on the 
content type and other parameters specified during the design of the dashboard. See step 3 on 
page 67 for information on selecting the content of start page.

Each content type has a specific look and feel, and a specific arrangement of portlets. The 
top-level view of the dashboard on the start page depends on the preselected contents.

Business-IT Centric View

This view consists of four portlets. The portlets and their contents are listed in Table 11.

Table 11 Portlets in Business-IT Centric View Page

Portlet Content

Business View Services • Health status
• Trend
• Potential Risks
• Alerts
• Links to associated composite service

Summary View • Status of all incidents and alerts

• Pie chart representation of alerts

• Percentage graph of service 
availability

All Alerts Description of all the alerts

Service Tree View Complete hierarchical structure of the 
dashboard
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Figure 7 Business-IT Centric View Page
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Service Manager Centric View

This view comprises of three portlets: the Service Summary portlet, the Key Metric portlet, 
and the Alerts portlet. The portlets and their contents are listed in Table 12.

Figure 8 Service Manager Centric View Page

Table 12 Portlets in Service Manager Centric View Page

Portlet Content

Service Summary • Health status
• Trend
• Potential Risks
• Alerts
• Links to associated composite service

Key Metrics • List of 

— Average critical alerts per hour
— Average number of incidents per 

hour
— Average number of service calls per 

hour

• Pie chart representation of alerts

• Percentage graph of service availability

Alerts Description of all the alerts
Using the Portal 87



IT-Operation Centric View

This view consists of four portlets. The portlets and their contents are listed in Table 13.

Figure 9 IT-Operation Centric View Page

Table 13 Portlets in IT-Operation Centric View Page

Portlet Content

Business View Services • Health status
• Trend
• Potential Risks
• Alerts
• Links to associated composite service

Alerts Description of all alerts.

Service Tree View Complete hierarchical structure of the 
dashboard.

Alert and Incident Graph 
View

• Pie chart representation of alerts and 
incidents.

• Percentage graph of service health.
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IT-Help Desk Centric View

The Help Desk view is designed to display the dashboard that uses a service desk 
management product (such as BMC Remedy Help Desk, HP Service Desk, and so on) as an 
underlying service. The portlets and their contents are listed in Table 14.

Table 14 IT-Help Desk Centric View Page

Portlet Content

Service Tree View Complete hierarchical structure of the 
dashboard

Help Desk Incidents 
Information

Description of all incidents

Executive Summary A summary of all the incidents, problems, 
changes, and service calls

Executive Summary View Two different portlets called Executive 
Summary View appear 

• The bottom portlet displays bar graph 
representation of service calls, 
incidents, and problems

• The extreme right portlet displays the 
following:

— Incident graph
— Pie-chart representation of service 

calls
— Measure of changes and problems

Alerts Description of all the alerts

PDF ReadUtility This portlet provides a utility to display 
PDF files stored in RealTime Health View 
server

RealTime Health View does not support Executive Summary and Executive 
Summary View portlets for HP Service Center. You can close these two portlets if 
you have generated an IT-Help Desk Centric View Dashboard for HP Service 
Center.
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Figure 10 IT-Help Desk Centric View Page
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Global Map View

Global Map view enables you to view the health and status of a service based on location. The 
view is designed to display one map per dashboard and aggregated service health for each 
location on the map. Global Map view contains World, EMEA, North America, APJ, and 
Custom geographical maps. The World, EMEA, North America, and APJ maps contains a list 
of pre-configured major cities of the region. Global Map view enables you to:

1 Configure an existing map.

2 Add new cities in an existing map.

3 Delete existing cities from a map.

4 Create a custom map.

For more information on how to perform these tasks, refer to the RealTime Health View 
Composer online help.

The portlets and their contents are listed in Table 15 

Table 15 Global Map View Page

Portlet Content

Operations Dasboard Brief description of HP Operations 
Dashboard.

GeoGraphical Map Status of the groups in a Dashboard 
through geographical map.

Key Metrics • List of 

— Average critical alerts per hour
— Average number of incidents per hour
— Average number of service calls per 

hour

• Pie chart representation of alerts

• Percentage graph of service availability

Alerts Description of all the alerts

HTTP DataSource Description of HTTP Datasource attached 
at Dashboard level.

SQL DataSource Description of SQL Datasource attached at 
Dashboard level.
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Figure 11 Global Map View Page

Composite Service Level View

On the dashboard page, all associated composite services are listed and hyperlinked in a 
portlet. To drill down to the next level, click the composite service link. The 
CompositeServiceBreakDown page opens. This page displays the list of associated elementary 
services and their associated health status information. 

Elementary Service Level View

In the CompositeServiceBreakDown page, all elementary services are hyperlinked in a 
portlet. To drill down to the elementary service level, click the composite service link. The 
ElementaryServices page opens and displays the health status of individual elementary 
services.

If Operations View is installed along with RealTime Health View, an additional level of 
drilldown is provided.
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Drill Down to Operations View

If you have Operations View installed, you can enable RealTime Health View to perform 
Operations View drilldown from the ElementaryServices page. To enable the drilldown from 
RealTime Health View to the Operations View portal, complete the following tasks:

1 Configure Operations View.
2 Configure RealTime Health View.

Task 1: Configure Operations View

You can configure this drilldown for services provided by HP Operations Internet Services, 
HP Operation Manager for Windows, HP Operations Serivce Desk, and HP Service Navigator.

To enable a drilldown to an existing Operations View portlet, map the portlet to the user anon 
in Operations View.

For more information on creating, configuring, and deploying portlet applications in 
Operations View, see the applicable HP Operations Dashboard Operations View Integration 
Guide for your particular HP Operations solution.

Task 2: Configure RealTime Health View

Perform the following steps to configure RealTime Health View:

1 Enter the Operations View URL in opsviewurl.properties file, which is located in 
<OvDataDir>\conf\dashboard\rhview\common. Sample URL of Operations View is 
http://<servername>:<port>/<opsView>
where <servername> is the hostname or IP address of machine hosting Operations View, 
<port> is the port number where Operations View is running, and <opsView> is webapp 
context name that is configured in Operations View.

2 Restart the portal server from the Dashboard Configuration Manager.

Drill Down to Operations Business Process Insight

If you have BPI Dashboard installed on the BPI system, you can enable RealTime Health 
View to perform drilldown to the BPI Dashboard to see the detail of a particular flow, metric, 
or threshold. To enable the drilldown from RealTime Health View to the BPI Dashboard, you 
need to edit the opsviewurl.properties file, which is located in 

In the case of HP Operations Internet Services, you can enable this drilldown for 
OVISDashboard portlets only.

In case of HP Service Navigator, HP Operations Manager for Unix and HP Operations 
Manager for Windows, you can enable drilldown for OVSNserviceGraph, OVSNBrowser, 
OVSNSvcHealth, and OVSNCards portlets only.

If you are using BEA WebLogic as portal server instead of the default Jetspeed, 
you must copy the opsviewurl.properties file from the location 
<OvDataDir>\conf\dashboard\rhview\common to 
<BEA-HOME>\user_projects\<Application Name>\<Project 
Name>\WEB-INF\classes where <Application Name> is the name of the 
application created in step 5 on page 55 and <Project Name> is the name of the 
project imported in step f on page 55.
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<OvDataDir>\conf\dashboard\rhview\common. Provide the following information in the 
Realtime Health View - Business Process insight Integration section of the 
opsviewurl.properties file:

• OVBPI_SYSTEM_HOST_NAME: represents the name of the system on which BPI is 
running.

• OVBPI_SERVER_PORT_NUMBER: represents the port on which BPI Dashboard is 
running. The default port is 44080.

• OVBPI_WEBAPP_NAME: represents the web application name for BPI Dashboard. The 
default web application name is ovbpidashboard2-10. For more information, refer to the 
BPI documentation.

After saving the opsviewurl.properties file, restart the Portal Server from the HP 
Operations Dashboard Configuration Manager.

Portlets for Data Sources

User-define data sources (HTTP and SQL data sources) are displayed inside portlets. 
User-defined data sources can be added at any level of the dashboard and they can appear in 
the dashboard page or in the CompositeServiceBreakdown page, depending on how they are 
modeled in the composer at design time.

You can view two different types of user-defined data sources in the portal:

• HTTP data source, displayed as:

— Raw data — displays contents of a web page in a portlet.

— Configured URL — displays a hyperlink to a web page in a portlet.

• SQL data source — You can display SQL data sources in the form of raw data that 
displays as a database table in a portlet. You can also display SQL data source in the form 
if graphs by using the SQL Datasource Visualization portlet. See SQL Datasource 
Visualization Portlet on page 94 for more information.

For more information, see the section Create Data Sources on page 60.

SQL Datasource Visualization Portlet

SQL Datasource Visualization portlet enables you to view the SQL data sources in the form of 
graphs and charts such as, XY Line graph and Pie chart. RealTime Health View provides you 
different portlets for different levels.

• SQL Datasource Visualization portlet - Dashboard level

• SQL Datasource Visualization portlet - Group level

• SQL Datasource Visualization portlet - Composite service level

• SQL Datasource Visualization portlet - Elementry service level

You need to add appropriate portlet to the portal server to view graphs based data source 
information. Perform the following steps to add the SQL Datasource Visualization portlet to 
your dashboard view.

1 Start the web portal.

You can add the Elementry service level visualization portlet to your dashboard if 
the runtime datatype for SQL datasource is set to status calculation.
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2 Log in to the portal server with your user name and password.

3 Select the dashboard on which you want to add the visualization portlet.

4 Click Edit in the top-left corner of the screen. The Customize page appears.

5 Click Add Portlet.

6 Search for the SQL Datasource portlet to show graphs at dashboard level and add it to 
your dashboard.

7 Click [Go Back].

8 The SQL DataSource portlet appears in your dashboard.

9 Click Edit. A data source list appears in the portlet.

10 Select your datasource. The Select graph type list appears.

11 Select the appropriate graph type from the list.

12 Select the appeopriate axis and click Submit.

The graph appears in the portlet.

Get Route Cause Portlet

The Get Route Cause portlet enables you to view the root cause service in dashboard. This 
portlet is available for OVO for Windows and HP Service Navigator. You can add 
GetRootCause portlet at the dashboard level to any of the available views such as, 
Business-IT Centric view and IT Operations Centric view.
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Add the GetRootCause portlet with description Get Root Cause portlet for Dashboard to your 
dashboard. See SQL Datasource Visualization Portlet on page 94 to know how to add a portlet 
to a dashboard. The portlet appears as follows. 

You can select the service from the dropdown list in the top-right corner to see the details.
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A Guidelines for Writing a Data Source 
Transformation Script
User-defined data sources such as SQL and HTTP data sources with the Runtime Data Type 
set to Status Calculation can be used as elementary services while creating a 
dashboard.These data sources are also referred to as user-defined services. To calculate the 
status of these user-defined services, you must provide a Perl transformation script while 
creating the underlying SQL/HTTP data source. You must follow the guidelines listed below 
to generate the transformation script.

1 The Perl script must accept the raw data of the data source as a command line argument.

2 The Perl script must process this raw data to generate an event. The generated event is 
an XML string that indicates the status of the user-defined service. 

3 The Perl script must return zero (0).

The schema of the event XML is given below.

Figure 12 Event Schema for Status Calculation

The elements of the schema are described below.

• Name — Enter a name of the event. It can be any string.

• Type — Set the type of the event to ALARM.

• Alert — Set this element to false.

• Value — Enter an integer value between one and five. One indicates the status of 
user-defined service is NORMAL and five indicates the status is CRITICAL.

• Service ID — Leave this element blank. This value is populated by RealTime Health 
View server.

This event XML script must be printed to stdout of the script.
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• Source — Leave this element blank. This value is populated by RealTime Health View 
server.

• Timestamp — Leave this element blank. This value is populated by RealTime Health 
View server.

• Attributes — It is an optional element.

— Attribute — This is a sub-element of the optional Attributes element. This 
element holds Name and Value elements.

      Name— Set this element to ALARMMESSAGE.

      Value — Set this to [CDATA] string with the alarm message.

A sample event XML string is given below..

<Events>
  <Event>
     <Name>ElementStatus</Name>
     <Type>ALARM</Type>
     <Value>4</Value>
     <ServiceID></ServiceID>
     <Source></Source>
     <Alert>false</Alert>
     <Timestamp></Timestamp>
     <Attributes>
       <Attribute>
         <Name>ALARMMESSAGE</Name>
         <Value><![CDATA[FTP Service RESPONSE_TIME is slow ]] >
         </Value>
     </Attribute>
   </Attributes>
  </Event>
</Events>

In the above example an event called ElementStatus is generated for a user-defined service 
with a status value of 4 (Major). It also generates an alarm message (FTP Service 
RESPONSE_TIME is slow). 
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B Using MSI Packages to Install RealTime Health 
View
If you want to install RealTime Health View manually by using the MSI packages, perform 
the following steps.

1 Install the following packages in the given sequence.

a HPOvJREB-01.05.002-WinNT4.0-release.msi

b HPOvJdkB-01.05.001-WinNT4.0-release.msi

c HPOvXpl-03.10.040-WinNT4.0-release.msi

d HPOvJxpl-03.10.040-WinNT4.0-release.msi

e HPOvDshRhvCo-02.10.000-WinNT4.0-release.msi

f HPOvDshRhvServ-02.10.000-WinNT4.0-release.msi

g HPOvDshRhvComp-02.10.000-WinNT4.0-release.msi

h HPOvDshJetSpd-02.10.000-WinNT4.0-release.msi

2 After installing packages, you must install Autopass from the command prompt to enable 
licensing. You cannot start RealTime Health View services without enabling the license. 
Perform the following steps to install Autopass.

a From the command prompt, change the directory to the folder containing 
HPOvLic-05.40.060-WinNT4.0-release.msi package, and then run the 
commands given below.

msiexec.exe /i HPOvLic-05.40.060-WinNT4.0-release.msi /qn 
INSTALLSTANDALONE=1

"%CommonProgramFiles%\Hewlett-Packard\HPOvLIC\demo"\hpovliccli -io 
"%OvDataDir%\conf\dashboard\rhview\server\ovdshrhvserv.txt"

3 To install MSDE 2000, go to the folder containing the MSDE 2000 package from the 
command prompt, and then run the following command.

Setup.exe DISABLENETWORKPROTOCOLS=0 SAPWD="ovd" 
INSTANCENAME="OVDASHBOARD" SECURITYMODE=SQL
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After installing MSDE 2000, you must start MSSQL$OVDASHBOARD service from Control 
Panel → Administrative Tools → Services.

4 To create a database from the command prompt, change directory to 
%OvInstallDir%\misc\dashboard\rhview\server, and then run the following 
command.

osql -E -S .\OVDASHBOARD -i eddb_script.sql
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To uninstall RealTime Health View by using the MSI packages, perform the following steps.

1 Click Start → Settings → Control Panel.

2 Click Add/Remove Programs. 

3 Uninstall the MSI packages in the given sequence.

a HPOvDshJetSpd-02.10.000-WinNT4.0-release.msi

b HPOvDshRhvComp-02.10.000-WinNT4.0-release.msi

c HPOvDshRhvServ-02.10.000-WinNT4.0-release.msi

d HPOvDshRhvCo-02.10.000-WinNT4.0-release.msi

e HPOvJxpl-03.10.040-WinNT4.0-release.msi

f HPOvXpl-03.10.040-WinNT4.0-release.msi

g HPOvJdkB-01.05.001-WinNT4.0-release.msi

h HPOvJREB-01.05.002-WinNT4.0-release.msi
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